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Démarrer avec la programmation en Python
En utilisant Python avec les produits TI-Nspire™, vous pouvez :

e ajouter des programmes Python aux fichiers TNS,
e créer des programmes Python en utilisant des modeéles,
e communiquer avec d’autres applications TI-Nspire™ afin de partager des données,

e communiquer avec TI-Innovator™ Hub et TI-Innovator™ Rover.

L'implémentation de Python dans I’environnement TI-Nspire™ est basée sur
MicroPython, un petit sous-ensemble de la bibliothéque standard Python 3 congue
pour les microcontréleurs. L'implémentation originale de MicroPython a été adaptée
pour étre utilisée par TI.

Remarque : Certaines réponses numériques peuvent varier par rapport aux résultats
des calculatrices en raison de différences dans les implémentations mathématiques
sous-jacentes.

Python est disponible sur les produits TI-Nspire™ suivants :

Unités Logiciel pour ordinateur

TI-Nspire™ CX Il Logiciel enseignant TI-Nspire™ CX Premium
TI-Nspire™ CX Il CAS Logiciel enseignant TI-Nspire™ CX CAS Premium
TI-Nspire™ CX II-T Logiciel TI-Nspire™ CX version Eléve

TI-Nspire™ CX II-T CAS | TI-Nspire™ CX CAS Student Software
TI-Nspire™ CX II-C
TI-Nspire™ CX II-C CAS

Remarque : Dans la plupart des cas, les fonctionnalités sont identiques entre la
calculatrice et les vues logicielles, mais des différences peuvent apparaitre. Ce guide
suppose que vous utilisez la calculatrice ou la vue calculatrice dans le logiciel.

Modules Python

Python dans I’'environnement TI-Nspire™ comprend les modules suivants :

Modules standard Modules TI
Mathématiques (math) Tl PlotLib (ti_plotlib)
Nombre aléatoire (random) Tl Hub (ti_hub)
Nombres complexes (cmath) [Tl Rover (ti_rover)
Temps (time) Tl System (ti_system)
Tl Draw (ti_draw)

Tl Image (ti_image)
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Remarque : Si vous possédez des programmes Python créés dans d’autres
environnements de développement, vous devrez peut-étre les modifier afin de les
exécuter sur la solution Python dans I'environnement TI-Nspire™. Les modules peuvent
utiliser des méthodes, des arguments et un ordonnancement des méthodes différents
dans un programme par rapport aux modules TI. Il convient en général d’étre attentif a
la compatibilité lors de I'utilisation de n’importe quelle version de Python et des
modules Python.

Lors du transfert de programmes Python d’une plate-forme non-Tl a une plate-forme TI
OU d’un produit Tl a un autre, n’oubliez pas que :

e les programmes qui utilisent les fonctionnalités du langage de base et les librairies
standard (math, random, etc.) peuvent étre portés sans modifications ;

e les programmes qui utilisent des bibliothéques spécifiques a une plate-forme, telles
que matplotlib pour PC ou modules Tl, devront étre modifiés avant d’étre exécutés
sur une autre plate-forme. Cela peut étre vrai méme entre les plates-formes TI.

Comme pour toute version de Python, vous devrez inclure des importations pour
utiliser toutes les fonctions, méthodes ou constantes contenues dans un module
donné. Par exemple, pour exécuter la fonction cos() du module mathématique, utilisez
les commandes suivantes :

>>>from math import *

>>>cos (0)
1.0

Pour une liste des menus avec leurs options et leurs descriptions, veuillez consulter la
section Guide des menus.

Installation d’un programme Python en tant que module
Pour enregistrer votre programme Python en tant que module :

e Dans I'éditeur, sélectionnez Actions > Installer en tant que module Python.

¢ Dans le Shell, sélectionnez Outils > Installer en tant que module Python.
Apres la sélection, les événements suivants se produisent :

e Lasyntaxe Python est vérifiée.
e Le fichier est enregistré et déplacé dans le classeur PyLib.

e Une boite de dialogue s’affiche pour confirmer que le fichier a été installé en tant
que module.

e Le fichier est fermé et le module est prét a I'emploi.

e Le nom du module sera ajouté au menu Plus de modules avec un élément de menu
from <module> import * .

Si vous prévoyez de partager ce module avec d’autres personnes, il est recommandé de
respecter les directives suivantes :

¢ Ne stockez qu’un seul module par fichier TNS.

Démarrer avec la programmation en Python 2



¢ Le nom du module correspond au nom du fichier TNS (par exemple, le module
"my_program" est dans le fichier "my_program.tns").

e Ajoutez une page Notes avant I'éditeur Python pour décrire I'objectif du module, la
version et les fonctions.

e Utilisez la fonction ver() pour afficher le numéro de version du module.

e (Facultatif) Ajoutez une fonction d’aide pour afficher la liste des méthodes dans la
fonction.
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Espaces de travail Python

Il existe deux espaces de travail pour votre programmation en Python : |'éditeur Python
et la console Python (Shell).

Editeur Python Console Python (Shell)

e Créer, modifier et sauvegarder des e Exécution des programmes Python

programmes Python e Utile pour tester de petits fragments

e Mise en évidence syntaxique et de codes

auto-indentation e Interaction avec I'historique de la

e Invite de commandes en ligne pour console pour sélectionner les entrées
vous guider avec les arguments de et sorties précédentes en vue de leur
fonction réutilisation

¢ Info-bulles pour indiquer la plage de |e Latouche énumere les variables
valeurs possibles utilisateur globales définies dans le
dernier programme exécuté pour une

e Latouche [var) énumere les variables L .
activité donnée

et les fonctions utilisateur globales
définies dans le programme en cours

e Raccourcis clavier

Remarque : Plusieurs programmes et consoles Python peuvent étre ajoutés a une
activité.

Editeur Python

L’éditeur Python est I'espace ol vous pouvez créer, modifier et sauvegarder des
programmes Python.

Ajout d’une page de I'éditeur Python

Pour ajouter une nouvelle page de I'éditeur Python dans I'activité en cours, appuyez
sur et sélectionnez Ajouter Python (Add Python) > Nouveau (New).

1 Add Calculator
8 2 Add Graphs
3 Add Geometry
& 4 Add Lists & Spreadsheet
) 5 Add Data & Statistics
6 Add Notes
7 Add Vernier DataQuest™
@ 8 Add Widget
9 Add Program Editor

»
3 [AVAdaByihan

= O
3 Shell

Vous pouvez créer un script vierge, ou vous pouvez sélectionner un modele.

Script vierge Modéle
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[samped ]
L]

oK | Cancel

Elank

New

Namez | |

Type: [ EBlank Program

OK  Cancel

L’éditeur Python s’affiche apres la création du programme. Si vous avez sélectionné un
modele, les instructions d’importation nécessaires s’ajoutent automatiquement (voir

ci-dessous).

Remarque : Vous pouvez avoir plusieurs programmes dans un seul fichier TNS, tout
comme pour d’autres applications. Si le programme Python est destiné a étre utilisé
comme module, le fichier TNS peut étre enregistré dans le dossier PyLib. Ce module
peut ensuite étre utilisé dans d’autres programmes et classeurs.

Calculs mathématiques

) *Templates.py 5/5 [ *Templates.py 616
# Math Calculations # Random Simulations

Simulations aléatoires

from math import *

from math import *
from random import *

Graphiques géométriques

Traitement d’image

B *Templates.p 5/5 @ *Templates.py 6/6
[# Geometry phics #Image 9
from ti_draw import * from ti_image import *

from t_draw import get_screen_dim
Tracer (x,y) et Texte Partage de données
B *Templates.py 5/5 B *Templates.py 55|
[# Plotting (y) & Te #Data Sharing

import ti_plotiib as plt

from ti_system import *

Projet TI-Innovator Hub

Codage TI-Rover
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< [EEN *Doc rap 1] X

) *Templates.py 99

[# Hub Project

from ti_hub import * import ti_rover as rv
from math import * from math import *

from time import sleep
from ti_plotlib import text_at,cls
from ti_system import get_key

Ouverture d’un programme Python

Pour ouvrir un programme Python existant, appuyez sur et sélectionnez Insérer
(Insert) > Ajouter Python (Add Python) > Ouvrir (Open). Une liste des programmes
enregistrés dans le fichier TNS s’affiche.

Si la page de I'éditeur utilisée pour créer le programme a été supprimée, celui-ci est
toujours disponible dans le fichier TNS.

Utilisation de I’éditeur Python

En appuyant sur le menu Outils Classeur (Document Tools) s’affiche. Grace a ces
options de menu, vous pouvez ajouter, déplacer et copier des blocs de code pour votre
programme.

Menu Outils du Classeur

[ 1 Actions o 20 1] X m
> 2 Run » b2 Run , T
E9 3 Edit Ve E9 3 Edit L ——
1. 4 Built-ins » 8 1 def functiond: SEVSIWLERS

V5 Math 3 [+ 2 rewrn ! Control »

@ 6 Random ’ @ 6 Random 3 Ops H

L7 TIPltio > 7 TIPotp 4 Lists >

@ 8 TIHub » @8 Tl Hub 5 Type M

# 9 TIRover ’ < 9 Tl Rover © 10 >

& A More Modules ¥ & A More Modules }

vr B Variables 4 vr B Variables »

Les éléments sélectionnés dans les menus du module ajouteront automatiquement un
modeéle de code a I'éditeur avec des invites de commandes en ligne pour chaque partie
de la fonction. Vous pouvez naviguer d’un argument a I'autre en appuyant sur
(avancer) ou [eshi)+[tab] (retour). Des info-bulles ou des listes contextuelles s’afficheront
lorsqu’elles seront disponibles pour vous aider a sélectionner les bonnes valeurs.

Invites de commandes en ligne  Info-bulles

N *Doc rao [I] X <« K5l *Doc I E
B *Samples.py 344 A *Samples.py 313
ffrom t_draw import * from t_draw import *

1,blue)

def| (argument): set_color(Elllare
block 0-255

Listes contextuelles
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) *Samples.py 33

from ti_draw import *

Les numéros a droite du nom du programme indiquent le numéro de ligne actuel du
curseur et le nombre total de lignes du programme.

B Samples.py
ffrom math mport *

=2
y=4.5
z=pi
def 111

retul 2

def 22(n):
return n**3

Les fonctions et variables globales définies dans les lignes au-dessus de la position
actuelle du curseur peuvent étre insérées en appuyant sur et en les sélectionnant
dans la liste.

B Samples.py 1111
from math import *
x=2
yoas |
at fo 2
def 1(n): var x
return n*2 iy
wr 2

def 2(n):
return n*]

Lorsque vous ajoutez du code a votre programme, I'éditeur affiche des mots-clés, des
opérateurs, des commentaires, des chaines de caracteres et des indentations de
différentes couleurs pour vous aider a identifier les différents éléments.

[ *Pythagoras.py 99
4ef T(a,b,0):
retUMn(@*2+h*2-cH3)

print('Right triangle")
lse:

else:
print("Non-right triangle")

Les éléments du menu collés sont placés sur la ligne en cours ou sur la ligne suivante,
selon le contexte.

Inférieure a v6.2.0. v6.2.0 et supérieures
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@ *plpy 22 @ *p2.py A

import ti_rover as v iMport ti_fover as v
rv.forwardGrv.left(90rv.forward(3))) rv.forward(3)
1v.left(30)
v.forward(3)
grid units

Le menu principal affiche le menu du module en fonction du programme en cours
d’édition, ce qui permet d’accéder plus rapidement a ces options. Un seul module
s’affiche a la fois.

2 Run
3 Edit
4 Built-ins
5 Math
6
7

»
»
»
»

Randomn 4

Tl PlotLib 4

@ 8 TIHub 4

#* 9 TRRover »

& A More Modules 4

& B Vemier Go Direct™ »

Le menu Edition (Edit) affiche les éléments du menu et les raccourcis les plus souvent
utilisés.

Inférieure a v6.2.0. v6.2.0 et supérieures
1 - . # 1 Acti
b Aiww Indent (TAB) 5 g s
o5 WL 2 Dedent (Shift +TAB) PSSR 1_indent (TAS)
Mgy @ CommentUncomment (Clri+T) = 4 Buit-2 Dedent (Shift +TAB)
= 4 Insert Multi-line String - 3 Comment/Uncomment (Ctrl+T)
-5 Math X5 M 4 insert Mulj-tne Sting
@ 6 Rand @6 Rand
K 5 Find... (Ctri+F)
I57 m IE> 7 TIPlg papiace (Cirishn
& il 8 Beginning of Line (Ctrl+&) DUl 7 GotoLine.. (Cul+G)
9 TR} &9 TIR|
9 End of Line (Ctri+2) 8 Insert Line Above
& A Mo % A Mor
po A Jump to Top (Ctri+7) & B Ver
B Varillg Jump to Bottom (Ciri+1) I A Goto NextLine (Ciri+Enter)

Sauvegarde et exécution des programmes

Lorsque vous avez terminé votre programme, appuyez sur et sélectionnez Exécuter
(Run) > Vérifier la syntaxe et sauvegarder (Check Syntax & Save). Cela permettra de
vérifier la syntaxe du programme Python et de le sauvegarder dans le fichier TNS.

Remarque : Si des modifications de votre programme n’ont pas été sauvegardées, un
astérisque s’affiche a c6té du nom du programme.

1.1
) *Pythagoras.py 3R

Pour exécuter le programme, appuyez sur et sélectionnez Exécuter (Run) > Exécuter
(Run). Cela exécutera le programme courant dans la page Shell Python suivante ou dans
une nouvelle page si la page suivante n’est pas une page Shell.

Remarque : L'exécution du programme vérifie automatiquement sa syntaxe, puis le
sauvegarde.
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Console Python (Shell)

La console Python (Shell) est I'interpréteur qui exécute vos programmes Python,
d’autres fragments de code Python ou de simples commandes.

Code Python Commandes simples

3 Python Shell 10/10 D Python Shell 1112)
>>>foriin range(S): >>3243

L. +eprini(*)

Ajout d’une page de console Python

Pour ajouter une nouvelle page de console Python dans I’activité en cours, appuyez sur
et sélectionnez Ajouter Python (Add Python) > Shell.

1 Add Calculator
@ 2 Add Graphs
3 Add Geometry
[ 4 Add Lists & Spreadsheet
M 5 AddData & Statistics
6 Add Notes
7 Add Vernier DataQuest™
& 8 AddWidget
[ 9 Add Program Editor
(3 A Add Python

La console Python peut également étre lancée a partir de I'éditeur Python en exécutant
un programme via la touche et en sélectionnant Exécuter (Run) > Exécuter (Run).

*Pythagoras

[ Python Shell 3

>>>#Running Pythagoras.py
>>>from Pythagoras import *
55>

Utilisation de la console Python (Shell)

En appuyant sur le menu Outils Classeur (Document Tools) s’affiche. Grace a ces
options de menu, vous pouvez ajouter, déplacer et copier des blocs de code.

Menu Outils du Classeur

3 Tools o B ¥ 1 Tools )
2 Edt » B 2 Edit » "
. 3 Bult-ins ’ P 1 def functiond: TNl

4 Math b [V .2 return ) Control  »

@ 5 Random » @ 5 Random 3 Ops 4

L6 TIPlotib > £6 TPl 4 Usts >

@ 7 TIHub ’ €7 Tl Hub 5 Type ¥

# & Tl Rover , # 8 Tl Rover @ 1© !

& 9 More Modules » & 9 More Modules

var A Variables » var A Variables »
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Remarque : Si vous utilisez une méthode de I'un des modules disponibles, veillez a
exécuter d’abord une instruction d’'importation de module comme dans tout
environnement de codage Python.

L’interaction avec les sorties de la console est similaire a I'application Calculs ol vous
pouvez sélectionner et copier les entrées et sorties précédentes pour les utiliser ailleurs
dans la console, I'éditeur ou d’autres applications.

Fléche vers le haut pour sélectionner, puis copier et coller a I’'endroit souhaité

[ Python Shell 3/4

>>>from math Import *
>>>sin(pi2)
10

EESS

Les fonctions et variables globales du dernier programme exécuté peuvent étre
insérées en appuyant sur ou [])+(L] et en sélectionnant dans la liste, ou appuyez
sur et sélectionnez Variables > Vars : Dernier programme exécuté.

Pour choisir parmi une liste de fonctions et de variables globales provenant a la fois du
dernier programme exécuté et des modules importés, appuyez sur et sélectionnez
Variables > Vars : Tout.

Menu Variables

Tools
Edit »
Built-ins
Math
Random

Tl PlotLib
Tl Hub

Tl Rover »
& S More Modules »
vir A Variables

B X

QFE 8% F
~No|ae|wn -

4
©

2 Vars: All

Les variables du dernier programme exécuté  Toutes les variables

*Samples

8 Python Shell 303 [E3 Python Shell fia acosh
>>>#Running Samples.py >>>#Running Samples, J© asin
::‘from Samples import * Z:i‘ﬂ'om Samples impo ?XI asinh
i atan
[ | fio atan2
foa f2 fta atanh
o1 ¥ fea ceil
L2y fi4 copysign

12z fea cos
fi cosh

fn_dearess

Toutes les pages de console Python de la méme activité partagent le méme état (les
variables définies par I'utilisateur et importées). Lorsque vous enregistrez ou exécutez
un programme Python dans cette activité ou lorsque vous appuyez sur et
sélectionnez Outils (Tools) > Réinitialiser la console (Reinitialize Shell), I’historique de la
console aura alors un fond gris indiquant que I'état précédent n’est plus valide.

Avant la sauvegarde ou la réinitialisation ~ Apres la sauvegarde ou la réinitialisation
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*Samples *Samples

[ Python Shell 5/5 A Python Shell )

>>>#Running Samples.py >>>#Running Samples.py
>>>from Samples import * >>>from Samples import *
>33y >33y
4.5 1.5
>>> >3y
Traceback (most recent call last):
File "<stdir line 1, in <module>

NameError: name ‘y' isn't defined
>5>

Remarque : L'option Outils (Tools) > Effacer I’historique (Clear History) efface I'écran
de toute activité antérieure dans la console, mais les variables sont toujours
disponibles.

Messages

Des messages d’erreur et d’autres informations peuvent s’afficher lorsque vous vous
trouvez dans une session Python. Si une erreur s’affiche dans la console lorsqu’un
programme s’exécute, un numéro de ligne de programme s’affiche. Appuyez sur
et sélectionnez Accéder a I‘éditeur Python (Go to Python Editor). Dans I'éditeur,
appuyez sur puis sélectionnez Modifier (Edit) > Aller a la ligne (Go to Line). Saisissez
le numéro de la ligne et appuyez sur [enter]. Le curseur s’affichera sur le premier
caractere de la ligne ou I'erreur s’est produite.

Interruption de I’exécution d’un programme

Lors de I'exécution d'une fonction ou d'un programme, le pointeur en forme d'horloge
® s'affiche.

» Pour arréter la fonction ou le programme,

- Windows® : Appuyez sur la touche F12.

- Sur Mac® : Appuyez sur la touche F5.

- Unité : Appuyez sur la touche [@lon].

11  Espaces de travail Python



Guide des menus Python

Cette section énumere tous les menus et les options de menu de I'éditeur et de la
console Python. Elle fournit une bréve description de chacun élément.

Remarque : Pour les options de menu dotées de raccourcis clavier, les utilisateurs de
Mac® doivent remplacer Ctrl par 3 (Cmd) partout ou il est utilisé. Pour obtenir une liste
complete des raccourcis pour le logiciel et les unités TI-Nspire™, consultez le Guide
numérique de la technologie TI-Nspire™.

MenNU ACLIONS ... . 12
Menu Exécuter (RUN) ... ... . 13
Menu Outils ... . 13
Menu EdItion (EAit) ... 14
Menu Commandes natives (BUilt-ins) .......... ... i 16
Menu Mathématiques (Math) ... .. 18
Menu Nombre aléatoire (Random) ... ... ... i 19
Menu TIPlotLib ... . 20
Menu TEHUD o 22
MenU TEROVEI L. 34
Menu nombres complexes (ComplexMath) ........................................... 42
MENU TIMe L 42
Menu Tl SyStem 43
MeENU TIEDIaW ..o 44
Menu Tl Image .. 46
Menu Variables ... . 48
Menu Actions
Remarque : Cela s’applique uniquement a I'éditeur.
Elément descriptions
Nouveau (New) Ouvre la boite de dialogue Nouveau (New) : elle
permet de saisir le nom du nouveau programme et
d’en sélectionner le type.
Ouvrir Ouvre une liste des programmes disponibles dans le
classeur courant.
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Elément

descriptions

Créer une copie (Create Copy)

Ouvre la boite de dialogue Créer une copie (Create
Copy) : elle permet d’enregistrer le programme
courant sous un autre nom.

Renommer Ouvre la boite de dialogue Renommer (Rename) :
elle permet de renommer le programme courant.

Fermer Ferme le programme courant.

Paramétres Ouvre la boite de dialogue Réglages (Settings) : elle

permet de modifier la taille de la police pour
I’éditeur et la console (Shell).

Installer en tant que module
Python

Vérifie la syntaxe Python du fichier TNS actuel et le
déplace vers le dossier PyLib.

Menu Exécuter (Run)

Remarque : Cela s’applique uniquement a I'éditeur.

Raccourcis

Elément clavier descriptions

Exécuter Ctrl+R Vérifie la syntaxe du programme,
I'enregistre puis I'exécute dans
une console Python.

Vérifier la syntaxe et enregistrer Ctrl+B Vérifie la syntaxe et enregistre le

(Check Syntax & Save) programme.

Accéder au Shell (Go to Shell) N/D Active la console (Shell) liée au
programme en cours ou ouvre
une nouvelle page du Shell a
coté de I'éditeur.

Menu Outils

Remarque : Cela s’applique uniquement a la console (Shell).

Raccourcis

Elément clavier descriptions

Réexécuter le dernier Ctrl+R Réexécute le dernier programme

programme associé a la console en cours.

Accéder a I'éditeur Python N/D QOuvre la page de I'éditeur relative a la
console en cours.

Exécuter N/D Ouvre une liste des programmes
disponibles dans le classeur courant.
Apres la sélection, le programme choisi
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Elément

Raccourcis
clavier

descriptions

est exécuté.

Effacer historique

N/D

Efface I'historique de la console en
cours, mais ne réinitialise pas la
console.

Réinitialiser la console

N/D

Réinitialise I'état de toutes les pages
ouvertes de la console pour I'activité en
cours.

Toutes les variables définies et les
fonctions importées ne sont plus
disponibles.

dir()

N/D

Affiche la liste des fonctions dans le
module spécifié lorsqu’il est utilisé
apres l'instruction d’importation.

From PROGRAM import *

N/D

Ouvre une liste des programmes
disponibles dans le classeur courant.
Apres la sélection, I'instruction
d’importation est collée dans la
console.

Installer en tant que module
Python

N/D

Activé uniquement pour les modules au
format binaire. Déplace le fichier TNS
actuel vers le dossier PyLib.

Menu Edition (Edit)

Remarque : Ctrl+A sélectionne toutes les lignes de code ou les données de sortie afin de
les couper ou de les supprimer (éditeur uniquement), ou de les copier-coller (éditeur et

Shell).

Elément

Raccourci
clavier

Description

Indentation

TAB*

Indente le texte sur la ligne en cours
ou sur les lignes sélectionnées.
* Si des invites de commandes en

ligne sont incomplétes, TAB passera
a l'invite suivante.

Désindentation

Maj+TAB**

Désindente le texte sur la ligne en
cours ou sur les lignes sélectionnées.
* Si des invites de commandes en
ligne sont incompletes, Maj+TAB
passera a l'invite précédente.

Commenter/Décommenter

Ctrl+T

Ajoute/supprime le symbole
commentaire au/du début de la
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Raccourci
clavier

Description

ligne en cours.

Insérer une chaine de
caracteres de plusieurs lignes

N/D

(éditeur uniquement) Insére un
modéle de chaine de caractéres de
plusieurs lignes.

Rechercher

Ctrl+F

(éditeur uniquement) Ouvre la boite
de dialogue Rechercher (Find) et
recherche la chaine saisie dans le
programme actuel.

Remplacer

Ctrl+H

(éditeur uniquement) Ouvre la boite
de dialogue Remplacer (Replace) et
recherche la chaine saisie dans le
programme actuel.

Aller a la ligne

Ctrl+G

(éditeur uniquement) Ouvre la boite
de dialogue Aller a la ligne (Go to
Line) et saute a la ligne spécifiée
dans le programme courant.

Début de ligne

Ctrl+8

Déplace le curseur au début de la
ligne courante.

Fin de ligne

Ctrl+2

Déplace le curseur a la fin de la ligne
courante.

Aller au début (Jump to Top)

Ctrl+7

Déplace le curseur au début de la
premiére ligne du programme.

Aller a la fin (Jump to Bottom)

Ctrl+1

Déplace le curseur a la fin de la
derniére ligne du programme.

Effacer une ligne

Ctrl+del

Efface la ligne sur laquelle le curseur
est placé.
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Menu Commandes natives (Built-ins)

Fonctions

Elément

descriptions

def function():

Définit une fonction qui dépend de variables spécifiées.

return Définit la valeur générée par une fonction.

Controle (Control)

Elément descriptions

if.. Instruction conditionnelle.
if..else.. Instruction conditionnelle.
if..elif..else.. Instruction conditionnelle.

for index in range(size):

Itere sur une plage.

for index in range(start,stop):

Itére sur une plage.

for index in range(start,stop,step):

Itere sur une plage.

for index in list:

Itére sur les éléments d’une liste.

while.. Exécute les instructions dans un bloc de code
jusqu’a ce qu’une condition soit évaluée a Faux.
elif: Instruction conditionnelle.
else: Instruction conditionnelle.
Ops
Elément descriptions
X=y Définit la valeur de la variable.
X==y Colle I'opérateur de comparaison « égal a » (==).
xl=y Colle I'opérateur de comparaison « différent de » (!=).
x>y Colle I'opérateur de comparaison « strictement supérieur a » (>).
xX>=y Colle I'opérateur de comparaison « supérieur ou égal a » (>=).
X<y Colle I'opérateur de comparaison « strictement inférieur a » (<).
X<=y Colle I'opérateur de comparaison « inférieur ou égal a » (<=).
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Elément descriptions

et Colle I'opérateur logique « et » (and).

—ou— Colle I'opérateur logique « ou » (or).

non Colle I'opérateur logique « non » (not).

Vrai Colle la valeur booléenne Vraie (True).

Faux Colle la valeur booléenne Faux (False).
liste

Elément descriptions

(0

Colle les crochets ([]).

list() Convertit une séquence en type « liste ».

len() Renvoie le nombre d’éléments de la liste.

max() Renvoie la valeur maximale de la liste.

min() Renvoie la valeur minimale de la liste.
.append() La méthode rajoute un élément a une liste.
.remove() La méthode supprime la premiére instance d’un

élément d’une liste.

range(start,stop,step)

Renvoie un ensemble de nombres.

for index in range(start,stop,step)

Utilisé pour itérer sur une plage.

.insert() La méthode ajoute un élément a la position
spécifiée.

.split() La méthode renvoie une liste dont les éléments
sont séparés par le délimiteur spécifié.

sum() Renvoie la somme des éléments d’une liste.

sorted() Renvoie une liste triée.

.sort() La méthode trie une liste en place.

Type

Elément descriptions

int() Renvoie une partie entiére.

float() Renvoie un nombre a virgule flottante.
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Elément

descriptions

round(x,ndigits)

Renvoie une valeur a virgule flottante arrondie au nombre de
chiffres spécifié.

str() Renvoie une chaine de caractéres.
complex() Donne un nombre complexe.
type() Renvoie le type de I'objet.
E/S
Elément descriptions
print() Affiche I'argument sous forme d’une chaine de caractéres.
input() Invite I'utilisateur a saisir des données.
eval() Evalue une expression représentée sous forme d’une chaine de
caractéres.
format() La méthode formate la chaine de caractéres spécifiée.

Menu Mathématiques (Math)

Remarque : Lors

de la création d’un nouveau programme qui utilise ce module, il est

recommandé d’utiliser le type de programme Calculs mathématiques (Math

Calculations). Ce

ci garantit que tous les modules nécessaires sont importés.

Elément descriptions

from math import * Importe toutes les méthodes (fonctions) du module math.

fabs() Renvoie la valeur absolue d’un nombre réel.

sqrt() Renvoie la racine carrée d’un nombre réel.

exp() Renvoie e**x.

pow(x,y) Renvoie x élevé a la puissancey.

log(x,base) Retourne le logy e (X).
log(x) sans base donne le logarithme népérien de x.

fmod(x,y) Renvoie la valeur de x modulo y. A utiliser lorsque x et y sont
des nombres en virgule flottante.

ceil() Renvoie le plus petit entier supérieur ou égal a un nombre
réel.

floor() Renvoie le plus grand nombre entier inférieur ou égal a un
nombre réel.
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Elément

descriptions

trunc() Troncature d’un nombre réel, donne un nombre entier.
frexp() Retourne la mantisse et I'exposant d’'un nombre x, comme
paire (y,n) telle que x ==y * 2%*n,
Const
Elément descriptions
C: Returns value for the constant e.
pi Returns value for the constant pi.
Zoom trigo
Elément descriptions
radians() Convertit un angle de degrés en radians.
degrees() Convertit un angle de radians en degrés.
sin() Renvoie le sinus de I'argument exprimé en radians.
cos() Renvoie le cosinus de I'argument exprimé en radians.
tan() Renvoie la tangente de I'argument exprimé en radians.
asin() Renvoie I'Arc sinus de I'argument exprimé en radians.
acos() Renvoie I'Arc cosinus de I'argument exprimé en radians.
atan() Renvoie I'Arc tangente de I'argument exprimé en radians.
atan2(y,x) Renvoie I’Arc tangente de y/x exprimé en radians.

Menu Nombre aléatoire (Random)

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Simulations aléatoires (Random
Simulations). Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

from random import * Importe toutes les méthodes du module nombres
aléatoires.

random() Renvoie un nombre a virgule flottante compris entre 0
et 1,0.
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Elément

descriptions

uniform(min,max)

Renvoie un nombre aléatoire x (a virgule flottante) tel
gque min <= x <= max.

randint(min,max)

Renvoie un nombre aléatoire entier compris entre min
et max.

choice(sequence)

Renvoie un élément aléatoire d’une séquence non vide.

randrange(start,stop,step)

Renvoie un nombre aléatoire d’une plage comprise
entre « start » et « stop » avec un pas « step ».

seed()

Initialise le générateur de nombres aléatoires.

Menu TI PlotLib

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Tracé (x,y) et texte (Plotting (x,y) & Text).
Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

import ti_plotlib as plt Importe toutes les méthodes (fonctions) du module ti_

plotlib dans I'espace de nom « plt ». Par conséquent, tous
les noms de fonctions collés a partir des menus seront
précédés de « plt. ».

Config
Elément descriptions
cls() Efface la zone de représentation graphique.

grid(x-scale,y-scale,"style")

Affiche une grille basée sur les échelles spécifiées
pour les axes des x (x-scale) et des y (y-scale).

window(xmin,xmax,ymin,ymax)

Définit la fenétre de représentation graphique en
faisant correspondre I'intervalle horizontal (xmin,
xmax) et l'intervalle vertical (ymin, ymax) spécifiés
a la zone graphique allouée (pixels).

auto_window(x-list,y-list)

Met automatiquement a I’échelle la fenétre
graphique pour qu’elle corresponde a la plage de
données comprises dans les listes x (x-list) et y (y-
list) spécifiées dans le programme, préalablement
a la fonction auto_window().

axes("mode")

Affiche les axes sur la fenétre spécifiée dans la
zone graphique.

labels("x-label","y-label",x,y)

Affiche les noms des axes x (x-label) et y (y-label)
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Elément descriptions
sur la représentation graphique aux positions
définies respectivement par les arguments x et y.

title("title") Affiche le titre (title) centré sur la ligne supérieure
de la fenétre.

show_plot() Affiche le tracé en mémoire tampon.

Les fonctions use_buffer() et show_plot() sont
utiles lorsque I'affichage de plusieurs objets a
I’écran risque de provoquer des problemes des
ralentissements (dans certains cas).

use_buffer()

Active une mémoire tampon hors écran pour
accélérer le tracé.

Ponctuation

Elément

descriptions

color(red,green,blue)

Définit la couleur pour tous les graphiques/graphes
suivants.

cls()

Efface la zone de représentation graphique.

show_plot()

Exécute I'affichage de la représentation graphique tel
qu’elle est configurée dans le programme.

scatter(x-list,y-list,"mark")

Trace une séquence de paires ordonnées a partir des
listes de coordonnées x (x-list) et y (y-list) avec le style
de marquage (mark) spécifié.

plot(x-list,y-list,"mark")

Trace une ligne en utilisant des paires ordonnées des
listes de coordonnées x (x-list) et y (y-list) spécifiées.

plot(x,y,"mark")

Trace un point en utilisant les coordonnées x et y avec
le style de marquage (mark) spécifié.

line(x1,y1,x2,y2,"mode")

Trace un segment de droite allant de (x1,y1) a (x2,y2).

lin_reg(x-list,y-list,"display")

Calcule et dessine le modele de régression linéaire,
ax+b, des listes x (x-list) et y (y-list).

pen("size","style")

Définit I'apparence de toutes les courbes suivantes
jusqu’a ce que la fonction pen() suivante soit
exécutée.

nn

text_at(row,"text","align")

Affiche le texte (text) dans la zone graphique avec
I'alignement (align) spécifié.
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Propriétés

Elément descriptions

xmin Variable spécifiée pour les arguments de fenétre définis comme plt.xmin.

Xmax Variable spécifiée pour les arguments de fenétre définis comme plt.xmax.

ymin Variable spécifiée pour les arguments de fenétre définis comme plt.ymin.

ymax Variable spécifiée pour les arguments de fenétre définis comme plt.ymax.

m Apres I'exécution de plt.linreg() dans un programme, les valeurs calculées
de la pente m et de I'ordonnée a I'origine b, sont stockées dans plt.m et
plt.b.

b Apres I'exécution de plt.linreg() dans un programme, les valeurs calculées
de la pente a et de I'ordonnée a I'origine b, sont stockées dans plt.a et
plt.b.

Menu Tl Hub

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Projet hub (Hub Project). Ceci garantit
que tous les modules nécessaires sont importés.

Elément

descriptions

from ti_hub import * Importe toutes les méthodes du module ti_hub.

Dispositifs intégrés du hub > Sortie couleur

Elément descriptions

rgb(red,green,blue) Définit la couleur de la DEL RGB.

blink(frequency,time) Définit la fréquence (frequency) et la durée (time) de
clignotement pour la couleur sélectionnée.

off() Eteint la DEL RGB.

Dispositifs intégrés au Hub (Hub Built-in Devices) > Sortie lumiére (Light Output)

Elément descriptions
on() Allume la DEL.
off() Eteint la DEL.
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Elément

descriptions

blink(frequency,time)

Définit la fréquence (frequency) et la durée (time) de
clignotement de la DEL.

Dispositifs intégrés au Hub (Hub Built-in Devices) > Sortie audio (Sound Output)

Elément

descriptions

tone(frequency,time)

Joue une tonalité a la fréquence spécifiée pendant le
temps spécifié.

note("note",time)

Joue la note spécifiée pendant la durée (time)
spécifiée.

La note est spécifiée au moyen de son nom (en
anglais) et d’'une octave. Par exemple : A4, C5.

Les noms des notes (en anglais) sont C, CS, D, DS, E, F,
FS, G, GS, A, AS et B.

Les octaves sont comprises entre 1 et 9 (inclus).

tone(frequency,time,tempo) Joue une tonalité a la fréquence spécifiée pendant le

temps et au tempo spécifiés.
Le tempo définit le nombre de bips par seconde entre
0 et 10 (inclus).

note("note",time,tempo) Joue la note spécifiée pendant le temps et au tempo

spécifiés.

La note est spécifiée au moyen de son nom (en
anglais) et d’'une octave. Par exemple : A4, C5.

Les noms des notes (en anglais) sont C, CS, D, DS, E, F,
FS, G, GS, A, AS et B.

Les octaves sont comprises entre 1 et 9 (inclus).

Les valeurs de tempo sont comprises entre 0 et 10
(inclus).

Dispositifs intégrés au Hub (Hub Built-in Devices) > Entrée luminosité (Brightness

Input)
Elément descriptions
measurement() Lit le capteur de LUMINOSITE (niveau de lumiére) intégré et

retourne la valeur relevée.

La plage par défaut est de 0 a 100. Cela peut étre modifié via la
fonction range().

range(min,max)

Définit la plage pour la configuration des relevés du capteur de
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niveau de lumiere.
Si les deux valeurs sont manquantes, ou si

(de 0 a 100) est utilisée.

elles sont définies sur

une valeur évaluée a None, alors la plage de luminosité par défaut

Ajouter un dispositif d’entrée (Add Input Device)

Ce menu contient une liste des capteurs (dispositifs d’entrée) pris en charge par le
module ti_hub. Toutes les options du menu collent le nom de I'objet et attendent une
variable et un port utilisés avec le capteur. Chaque capteur possede une méthode

measurement() qui retourne la valeur mesurée.

Elément

descriptions

DHT (Capteur de température et d’humidité) (DHT, Digital Humid

itheav@imphe liste
comportant la
température,
I'humidité, le type de
capteur actuels et le
dernier état mis en
mémoire.

Ranger (Capteur de distance)

Renvoie la mesure de

la distance courante

issue du capteur de

distance a ultrasons

spécifié.

¢ measurement_
time() : renvoie le
temps pris par le
signal
ultrasonique pour
atteindre I'objet
(le « temps de
vol »).

Niveau de lumiere

Renvoie le niveau de
luminosité issu du
capteur de lumiere
externe (luminosité).

température

Renvoie la lecture de
la température issue
du capteur de
température externe.

La configuration par
défaut prend en

Guide des menus Python

24



m
[N

ment

descriptions

charge le capteur de
température Seeed
surles portsIN 1, IN 2
ou N 3.

Pour utiliser le capteur
de température Tl
LM19 du pack de
platines d’essais TI-
Innovator™ Hub,
modifiez le port sur la
broche BB en service
et utilisez un
argument optionnel

« TIANALOG ».
Exemple :

mylm19=temperature
("BB 5","TIANALOG")

Humidité

Renvoie la lecture du
capteur d’humidité.

Champ magnétique

Détecte la présence
d’un champ
magnétique.

La valeur seuil pour
déterminer la
présence du champ
est fixée par la
fonction trigger().
La valeur par défaut
du seuil est de 150.

App Vernier

Lit la valeur du
capteur analogique
Vernier spécifié dans
la commande.

La commande prend
en charge les capteurs
Vernier suivants :

e température :
capteur de
température en
acier inoxydable.

e niveau de lumiére :
capteur de niveau
de lumiere TI.
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e pression : capteur
de pression de gaz
d'origine.

e pression : capteur
de pression de gaz
plus récent.

e pH: capteur de
pH.

e forcel0 : réglage
+10 N, capteur de
force double
échelle.

e force50 : réglage
+50 N, capteur de
force double
échelle.

e accéléromeétre :
accélérometre
Low-G.

e générique :
permet le réglage
d’autres capteurs
non pris en charge
directement
comme ci-dessus
et I'utilisation de
I’API calibrate() ci-
dessus pour
définir des
coefficients
d’équation.

Entrée analogique

Prend en charge
I'utilisation de
dispositifs génériques
d’entrée analogique.

Entrée numérique

Renvoie I'état actuel
de la broche
numérigue connectée
a l'objet DIGITAL ou
|’état de mise en
cache de la valeur de
sortie numérique
DEFINIE en dernier
lieu sur I'objet.
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Elément

descriptions

Potentiomeétre

Prend en charge un
potentiometre.

La plage du capteur
peut étre modifiée par
la fonction range().

Thermistor

Lit le thermistor.

Les coefficients par
défaut sont adaptés
au thermistor inclus
dans le pack de platine
d’essais Tl-Innovator™
Hub, lorsqu’il est
utilisé avec un résistor
fixe de 10 kQ.

Un nouveau jeu de
coefficients
d’étalonnage et une
résistance de
référence pour le
thermistor peuvent
étre configurés a I'aide
de la fonction
calibrate().

Intensité sonore

Prend en charge les
capteurs de niveau
sonore.

Entrée couleur

Fournit des interfaces
a un capteur
colorimétrique
d’entrée connecté au
port 12C.

La broche bb_port est
utilisée en plus du
port 12C pour
contrdler la DEL du
capteur de couleur.

e color_number():
Retourne une
valeur comprise
entre 1 et 9 qui
représente la
couleur détectée
par le capteur.
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Les chiffres
représentent les
couleurs selon les
correspondances

suivantes :

© 0 N o U ok w N R

: Rouge

Vert
Bleu

Cyan

: Magenta

Jaune

Noir

: Blanc

: Gris

red(): Retourne
une valeurde 0 a
255 qui
représente
I'intensité du
niveau de couleur
ROUGE détecté.

green(): Retourne
une valeurde O a
255 qui
représente
I'intensité du
niveau de couleur
VERTE détecté.

blue(): Retourne
une valeurde O a
255 qui
représente
I'intensité du
niveau de couleur
BLEUE détecté.
gray(): Retourne
une valeurde O a
255 qui
représente le
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Elément descriptions

niveau de gris
détecté, ou 0

correspond au
noir et 255 au
blanc.

Port BB Permet d’utiliser les
10 broches du port BB
comme un port
d’entrée/sortie
numeérique combiné.
Les fonctions
d’initialisation
disposent d’un
paramétre « masque
(mask) » optionnel qui
permet d’utiliser le
sous-ensemble de 10
broches.

e read_port(): Lit les
valeurs courantes
sur les broches
d’entrée du port
BB.

e write_port(value):
Regle la broche de
sortie a la valeur
spécifiée (la valeur
est comprise entre
0 et 1023). Notez
que la valeur est
également ajustée
par rapport a la
valeur du masque
dans I'opération
var=bbport(mask),
si un masque a été
fourni.

Hub Time Permet d’accéder au
timer interne (en
millisecondes).

TI-RGB Array Fournit des fonctions

pour la
programmation de TI-
RGB Array.
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La fonction
d’initialisation accepte
un parameétre
optionnel « LAMP »
pour activer le mode
haute luminosité de
TI-RGB Array. Il
requiert une
alimentation
électrique externe.

e set(led_position,
r,g,b): Regle la
valeurr,g,b
spécifiée pour la
DEL située a la
position (led_
position) spécifiée
(0-15).1,getb
sont des valeurs
comprises entre 0
et 255.

e set(led_
list,red,green,blu
e): Définit les DEL
de la « led_list »
sur la couleur
spécifiée
«rouge », « vert »
ou « bleu ». La
« led_list » est
une liste Python
qui inclut les index
des DEL de 0 a 15.
Par exemple, set
([0,2,4,6,15], 0, O,
255) définira les
DELO, 2,4, 6 et
15 sur le bleu.

e set_all(r,g,b):
Régle la méme
valeur r,g,b pour
toutes les DEL
RGB de la matrice.

o all_off(): Eteint
toutes les DEL
RGB de la matrice.
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e measurement():
Retourne la valeur
approximative du
courant
consommeé (en
milliamperes) sur
Tl-Innovator™ par
la matrice RGB.

e pattern(pattern):
L'argument
« pattern » est
une valeur binaire
de 16 bits (de 0 a
65 535), ol la
valeur « 1 » active
le pixel
correspondant.
Les DEL sont
allumées en
ROUGE avec une
valeur de niveau
MLI de 255.

e pattern
(value,red,green,bl
ue): Définit les DEL
caractérisées par
le « modeéle » sur
la couleur
spécifiée
«rouge », « vert »
ou « bleu ».

Ajouter un dispositif de sortie

Ce menu contient une liste des dispositifs de sortie pris en charge par le module ti_hub.
Toutes les options du menu collent le nom de I'objet et attendent une variable et un
port utilisés avec le dispositif.

Elément descriptions

VOYANT Fonctions de contréle des DEL connectées externes.

RVB Prise en charge du controle des DEL RGB externes.

TI-RGB Array Fournit des fonctions pour la programmation de TI-RGB
Array.

Haut-parleur Fonctions de prise en charge d’un haut-parleur externe avec
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Elément descriptions
le TI-Innovator™ Hub.
Les fonctions sont les mémes que celles relatives au « son »
décrites plus haut.

Puissance Fonctions de contréle des alimentations externes avec le TI-

Innovator™ Hub.

o set(value): Regle le niveau de puissance a la valeur
(value) spécifiée, entre 0 et 100.

e on(): Régle le niveau de puissance a 100.
o off(): Régle le niveau de puissance a 0.

Servomoteur continu

Fonctions de contrdle des servomoteurs continus.

e set_cw(speed,time): Le servomoteur tournera dans le
sens des aiguilles d’une montre a la vitesse (speed)
spécifiée (0-255) et pendant la durée (time) spécifiée (en
secondes).

e set_ccw(speed,time): Le servomoteur tournera dans le
sens inverse des aiguilles d’'une montre a la vitesse
(speed) spécifiée (0-255) et pendant la durée (time)
spécifiée (en secondes).

e stop(): Arréte le servomoteur continu.

Sortie analogique

Fonctions pour l'utilisation de dispositifs génériques d’entrée
analogique.

Moteur vibrant

Fonctions de contréle des moteurs vibrants.

e set(val): Regle I'intensité du moteur vibrant au niveau
« val » (0-255).

e off(): Eteint le moteur vibrant.
e on(): Met en marche le moteur vibrant au niveau le plus

élevé.
Relais Interfaces de contréle des relais.
e on(): Regle le relais sur I'état ON.
o off(): Regle le relais sur I'état OFF.
Servo Fonctions de contréle des servomoteurs.
e set_position(pos): Régle la position angulaire (pos) du
servomoteur entre -90° et +90°.
e zero(): Regle le servomoteur angulaire sur la position
zéro.
Squarewave Fonctions de génération d’un signal carré.

¢ set(frequency,duty,time): Regle le signal carré de sortie
avec un rapport cyclique (duty) par défaut de 50 % (s'il
n’est pas spécifié) et une fréquence de sortie spécifiée
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par « frequency ». La fréquence peut étre comprise
entre 1 et 500 Hz. Le rapport cyclique, s'il est spécifié,
peut étre compris entre 0 et 100 %.

off(): Désactive le signal carré.

Sortie numérique

Interfaces de contréle d’une sortie numérique.

set(val): Régle la sortie numérique a la valeur spécifiée
par « val » (O ou 1).

on(): Regle la sortie numérique a un niveau haut (1).
off(): Regle la sortie numérique a un niveau bas (0).

Port BB Fournit des fonctions pour la programmation de TI-RGB
Array.
Voir les détails ci-dessus.
Commandes
Elément descriptions

sleep(seconds)

Interrompt le programme pendant le nombre spécifié
de secondes.

Importé depuis le module « temps ».

non

text_at(row,"text","align")

Affiche, dans la zone de graphe, le texte (text) spécifié
avec I'alignement (align) spécifié.
Fait partie du module ti_plotlib.

cls()

Efface I’écran de la console (Shell) pour une
représentation graphique.
Fait partie du module ti_plotlib.

while get_key() !="esc":

Exécute les commandes dans la boucle « while »
jusqu’a ce que la touche d’échappement « esc » soit
enfoncée.

get_key()

Retourne une chaine représentant la touche enfoncée.
La touche « 1 » retourne « 1 », la touche
d’échappement retourne « esc », etc.

Lorsque la fonction est appelée sans paramétres (get_
key()), elle retourne immédiatement la chaine de
caracteres vide (").

Lorsque la fonction est appelée avec un parametre
(get_key(1)), elle attend qu’une touche soit enfoncée.
Fait partie du module ti_system.
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Ports

Ce sont les ports d’entrée et de sortie disponibles sur le Tl-Innovator™ Hub.

Elément

ouT1
out2
ouT3

IN1

IN 2

IN 3

BB 1

BB 2

BB 3

BB 4

BB 5

BB 6

BB 7

BB 8

BB 9

BB 10
“Porti2C

Menu TI Rover
Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est

recommandé d’utiliser le type de programme Codage du Rover (Rover Coding). Ceci
garantit que tous les modules nécessaires sont importés.

Elément descriptions

import ti_rover as rv Importe toutes les méthodes (fonctions) du module ti_rover
dans I'espace de nom « rv ». Par conséquent, tous les noms
de fonctions collés a partir des menus seront précédés de
«rv.»,
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Déplacement

Elément

descriptions

forward(distance)

Fait avancer le Rover de la distance spécifiée en unités
de grille.

backward(distance)

Fait reculer le Rover de la distance spécifiée en unités
de grille.

left(angle_degrees)

Fait tourner le Rover a gauche de I'angle spécifié en
degrés.

right(angle_degrees)

Fait tourner le Rover a droite de I'angle spécifié en
degrés.

stop()

Arréte immédiatement tout mouvement en cours.

stop_clear()

Arréte immédiatement tout mouvement en cours et
efface toutes les commandes en attente.

resume() Reprend le traitement des commandes.

stay(time) Le Rover est immobilisé pendant la durée spécifiée en
secondes (facultatif).
Si aucune durée n’est spécifiée, le Rover est immobilisé
pendant 30 secondes.

to_xy(x,y) Déplace le Rover a la position de coordonnées (x,y) sur

la grille virtuelle.

to_polar(r,theta_degrees)

Déplace le Rover a la position en coordonnées polaires
(r, théta) sur la grille virtuelle.

L’angle est spécifié en degrés.

to_angle(angle,"unit")

Fait tourner le Rover de I'angle spécifié dans la grille
virtuelle.

L’angle est défini par rapport a un angle nul qui pointe
vers le bas de I'axe des x dans la grille virtuelle.

Déplacement (Drive) > Options de déplacement (Drive with Options)

Elément

descriptions

forward_time(time)

Fait avancer le Rover pendant la durée
(time) spécifiée.

backward_time(time)

Fait reculer le Rover pendant la durée
(time) spécifiée.

forward(distance,"unit")

Fait avancer le Rover a la vitesse par
défaut sur la distance spécifiée.
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La distance peut étre spécifiée en unités
de grille, en métres ou en tours de roue
(unit).

backward(distance,"unit")

Fait reculer le Rover a la vitesse par défaut
sur la distance spécifiée.

La distance peut étre spécifiée en unités
de grille, en metres ou en tours de roue
(unit).

left(angle,"unit")

Fait tourner le Rover a gauche de 'angle
spécifié.

L’angle peut étre en degrés, en radians ou
en grades.

right(angle,"unit")

Fait tourner le Rover a droite de I'angle
spécifié.

L’angle peut étre en degrés, en radians ou
en grades.

forward_time(time,speed,"rate")

Fait avancer le Rover pendant la durée
(time) spécifiée et a la vitesse (speed)
spécifiée.

La vitesse peut étre spécifiée en unités de
grille/s, en métres/s ou en tours de roue/s.

backward_time(time,speed,"rate")

Fait reculer le Rover pendant la durée
(time) spécifiée et a la vitesse (speed)
spécifiée.

La vitesse peut étre spécifiée en unités de
grille/s, en métres/s ou en tours de roue/s.

forward(distance,"unit",speed,"rate")

Fait avancer le Rover sur la distance
spécifiée et a la vitesse (speed) spécifiée.
La distance peut étre spécifiée en unités
de grille, en métres ou en tours de roue
(unit).

La vitesse peut étre spécifiée en unités de
grille/s, en métres/s ou en tours de roue/s.

backward(distance,"unit",speed,"rate")

Fait reculer le Rover sur la distance
spécifiée et a la vitesse (speed) spécifiée.
La distance peut étre spécifiée en unités
de grille, en métres ou en tours de roue
(unit).

La vitesse peut étre spécifiée en unités de
grille/s, en métres/s ou en tours de roue/s.
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Entrées

Elément

descriptions

ranger_measurement()

Lit le capteur de distance a ultrasons situé a
I’avant du Rover et renvoie la distance courante en
meétres.

color_measurement()

Retourne une valeur comprise entre 1 et 9,
indiquant la couleur prédominante « vue » par le
capteur colorimétrique d’entrée du Rover.

1 =rouge

2 =vert

3 =bleu

4 =cyan

5 = magenta
6 = jaune

7 = noir

8 = gris

9 =blanc

red_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de rouge pergu par le capteur
colorimétrique d’entrée.

green_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de vert pergu par le capteur
colorimétrique d’entrée.

blue_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de bleu pergu par le capteur
colorimétrique d’entrée.

gray_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de gris pergu par le capteur
colorimétrique d’entrée.

encoders_gyro_measurement()

Renvoie une liste de valeurs qui contient le
comptage des encodeurs des roues gauche et
droite ainsi que le cap gyroscopique courant.

gyro_measurement()

Renvoie une valeur qui représente la lecture
courante du gyroscope, y compris la dérive, en
degrés.

ranger_time()

Renvoie le temps pris par le signal ultrasonique du
capteur de distance TI-Rover pour atteindre I'objet
(le « temps de vol »).
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Elément

descriptions

color_rgbh(r,g,b)

Régle la couleur de la DEL RGB du
Rover sur les valeurs spécifiées de
rouge, vert et bleu (r,g,b).

color_blink(frequency,time)

Définit la fréquence (frequency) et la
durée (time) de clignotement pour la
couleur sélectionnée.

color_off()

Eteint la DEL RGB du Rover.

motor_left(speed,time)

Régle la puissance du moteur gauche a
la valeur (speed) spécifiée pour la
durée (time) spécifiée.

La vitesse est comprise entre -255 et
255, 0 correspondant a I'arrét. Les
valeurs de vitesse positives
correspondent a une rotation dans le
sens inverse des aiguilles d’'une montre
et les valeurs de vitesse négatives a
une rotation dans le sens des aiguilles
d’une montre.

Le parametre optionnel de durée
(time), s'il est spécifié, a une plage
valide de 0,05 a 655,35 secondes. S'il
n’est pas spécifié, une valeur par
défaut de 5 secondes est utilisée.

motor_right(speed,time)

Régle la puissance du moteur gauche a
la valeur (speed) spécifiée pour la
durée (time) spécifiée.

La vitesse est comprise entre -255 et
255, 0 correspondant a I'arrét. Les
valeurs de vitesse positives
correspondent a une rotation dans le
sens inverse des aiguilles d’'une montre
et les valeurs de vitesse négatives a
une rotation dans le sens des aiguilles
d’une montre.

Le parametre optionnel de durée
(time), s'il est spécifié, a une plage
valide de 0,05 a 655,35 secondes. S'il
n’est pas spécifié, une valeur par
défaut de 5 secondes est utilisée.

motors("Idir",left_val,"rdir",right_val,time)

Reégle la roue gauche et la roue droite
sur les niveaux de vitesse spécifiés,
pour une durée (time) en secondes
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optionnelle.

Les valeurs de vitesse (left_val, right_
val) sont comprises entre 0 et 255, 0
correspondant a I'arrét. Les parametres
Idir et rdir spécifient la rotation en sens
horaire ou en sens antihoraire des
roues respectives.

Le parametre optionnel de durée
(time), s'il est spécifié, a une plage
valide de 0,05 a 655,35 secondes. S'il
n’est pas spécifié, une valeur par
défaut de 5 secondes est utilisée.

Chemin

Elément

descriptions

waypoint_xythdrn()

Lit I'abscisse x, I'ordonnée vy, la durée, la direction, la distance
parcourue, le nombre de tours de roue, le numéro de
commande au point de cheminement courant. Renvoie une
liste avec toutes ces valeurs en tant qu'éléments.

waypoint_prev

Lit I'abscisse x, I'ordonnée vy, la durée, la direction, la distance
parcourue, le nombre de tours de roue, le numéro de
commande au point de cheminement précédent.

waypoint_eta

Renvoie le temps estimé pour se rendre a un point de
cheminement.

path_done()

Renvoie une valeur 0 ou 1 selon que le Rover est en
mouvement (0) ou qu’il est completement immobilisé (1).

pathlist_x() Renvoie une liste des valeurs de x depuis le début jusqu’a la
valeur de x au point de cheminement courant comprise.
pathlist_y() Renvoie une liste des valeurs de y depuis le début jusqu’a la

valeur de y au point de cheminement courant comprise.

pathlist_time()

Renvoie une liste des temps en secondes depuis le début
jusqu’au temps au point de cheminement courant compris.

pathlist_heading()

Renvoie une liste des directions depuis le début jusqu’a la
valeur de la direction au point de cheminement courant
comprise.

pathlist_distance()

Renvoie une liste des distances parcourues depuis le début
jusqu’a la valeur de la distance au point de cheminement
courant comprise.

pathlist_revs()

Renvoie une liste du nombre de tours de roue effectués
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depuis le début jusqu’a la valeur du nombre de tours de roue
au point de cheminement courant compris.

pathlist_cmdnum()

Renvoie une liste de numéros de commande pour le chemin.

waypoint_x()

Renvoie I'abscisse x du point de cheminement actuel.

waypoint_y()

Renvoie I'ordonnée y du point de cheminement actuel.

waypoint_time()

Renvoie le temps de parcours entre le point de cheminement
précédent et le point de cheminement courant.

waypoint_heading()

Renvoie la direction absolue du point de cheminement
courant.

waypoint_distance()

Renvoie la distance parcourue entre le point de cheminement
précédent et le point de cheminement courant.

waypoint_revs()

Renvoie le nombre de tours de roue nécessaires pour
parcourir la distance entre le point de cheminement
précédent et le point de cheminement courant.

Paramétres
Elément descriptions
unités/s Option : vitesse en unités de grille par seconde.
m/s Option : vitesse en metres par seconde.
tr/s Option : vitesse en tours de roue par seconde.
unité Option : distance en unités de grille.
m Option : distance en métres.
tr Option : distance en tours de roue.
Degré Option : virage en degrés.
radians Option : virage en radians.
grades Option : virage en grades.

sens horaire

Option : spécification du sens de rotation de la roue.

sens antihoraire

Option : spécification du sens de rotation de la roue.

Commandes

Ces commandes sont un ensemble de fonctions provenant d’autres modules ainsi que

du module Tl Rover.

Guide des menus Python 40



Elément

descriptions

sleep(seconds)

Interrompt le programme pendant le nombre spécifié
de secondes.

Importées du module time.

non

text_at(row,"text","align")

Affiche le texte (text) dans la zone graphique avec
I'alignement (align) spécifié.
Importées du module ti_plotlib.

cls()

Efface I’écran de la console (Shell) pour une
représentation graphique.

Importées du module ti_plotlib.

while get_key() !="esc":

Exécute les commandes dans la boucle « while »
jusqu’a ce que la touche d’échappement « esc » soit
enfoncée.

wait_until_done()

Met le programme en pause jusqu’a ce que le Rover
termine la commande en cours.

Cela permet de synchroniser les commandes non
Rover avec les mouvements du Rover.

while not path_done()

Exécute les commandes dans la boucle « while »
jusqu’a ce que le Rover ait terminé tous ses
mouvements.

La fonction path_done() renvoie 0 ou 1 selon que le
Rover est en mouvement (0) ou qu’il est
complétement immobilisé (1).

position(x,y)

Définit la position du Rover sur la grille virtuelle aux
coordonnées x,y spécifiées.

position(x,y,heading,"unit")

Définit la position du Rover sur la grille virtuelle aux
coordonnées x,y spécifiées. Si une direction (heading)
est fourni (dans I'unité d’angle [unit] spécifiée), le cap
virtuel est fixé par rapport a I'axe x virtuel.

Les angles positifs de 0 a 360 sont considérés comme
étant dans le sens antihoraire par rapport a I'axe x
positif. Les angles négatifs de 0 a -360 sont considérés
comme étant dans le sens horaire par rapport a I'axe x
positif.

grid_origin()

Définit le RV comme étant a I'origine de la grille
actuelle, point (0,0).

grid_m_unit(scale_value)

Définit le quadrillage virtuel en métres par unité
(m/unité) a la valeur spécifiée. 0,1 constitue I'échelle
(en m/unité) par défaut : 1 unité = 100 mm ou 10 cm
ouldmou0,1m.

La plage des valeurs d’échelle (scale_value) valides est
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comprise entre 0,01 et 10,0.

path_clear()

Efface toutes les informations de chemin ou points de
cheminement préexistants.

zero_gyro()

Réinitialise le gyroscope du Rover a I'angle nul et
efface les compteurs des encodeurs des roues gauche
et droite.

Menu nombres complexes (Complex Math)

Ce sous-menu est situé sous Plus de modules (More Modules).

Elément

descriptions

from cmath import *

Importe toutes les méthodes du module cmath.

complex(real,imag)

Donne un nombre complexe.

rect(modulus,argument)

Convertit les coordonnées polaires d’'un nombre
complexe en coordonnées cartésiennes.

.real Renvoie la partie réelle du nombre complexe.

.imag Renvoie la partie imaginaire du nombre complexe.

polar() Convertit les coordonnées cartésiennes d’'un nombre

complexe en coordonnées polaires.

phase() Renvoie I'argument d’un nombre complexe.

exp() Renvoie e**x.

cos() Renvoie le cosinus d’'un nombre complexe.

sin() Renvoie le sinus d’'un nombre complexe.

log() Renvoie le logarithme népérien d’'un nombre complexe.

log10() Renvoie le logarithme en base 10 d'un nombre complexe.

sqrt() Renvoie la racine carrée d’'un nombre complexe.
Menu Time

Ce sous-menu est situé sous Plus de modules (More Modules).

Elément

descriptions

from time import *

Importe toutes les méthodes du module time.

sleep(seconds)

Interrompt le programme pendant le nombre spécifié de
secondes.

clock()

Retourne le temps courant du processeur sous la forme d’un
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nombre flottant exprimé en secondes.

localtime() Convertit un temps exprimé en secondes depuis le ler janvier
2000 en un tuple de neuf éléments contenant : I'année, le
mois, le jour du mois, I'heure, la minute, la seconde, le jour de
la semaine, le jour de I'année et un indicateur de I'heure d’été
(Daylight Savings Time, DST).

Si I'argument optionnel (secondes) n’est pas fourni, alors
I'horloge temps réel est utilisée.

ticks_cpu() Retourne un compteur croissant (en millisecondes) spécifique
au processeur (cpu) avec un point de référence arbitraire.
Pour mesurer le temps de maniére cohérente a travers
différents systemes, utilisez ticks_ms().

ticks_diff() Mesure la période entre deux appels consécutifs a la fonction
ticks_cpu() ou ticks_ms().

Cette fonction ne doit pas étre utilisée pour mesurer des
périodes de temps longues.

Menu TI System
Ce sous-menu est situé sous Plus de modules (More Modules).

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Partage de données (Data Sharing). Ceci
garantit que tous les modules nécessaires sont importés.

Elément descriptions

from ti_system import * Importe toutes les méthodes (fonctions) du module
ti_system.

recall_value("name") Rappelle la valeur (value) d'une variable prédéfinie
de I'OS nommée "name".

store_value("name",value) Stocke la valeur (value) d'une variable Python dans
une variable de I'0S nommée "name".

recall_list("name") Rappelle une liste prédéfinie de I'OS nommée
"name".

store_list("name",list) Stocke une liste Python (list) dans une variable de
type liste de I'OS nommée "name".

eval_function("name",value) Evalue une fonction prédéfinie de I'0S a la valeur
spécifiée.

get_platform() Retourne « hh » pour la calculatrice et « dt » pour

I'ordinateur de bureau.

get_key() Retourne une chaine représentant la touche
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enfoncée.

La touche « 1 » retourne « 1 », la touche
d’échappement retourne « esc », etc.

Lorsque la fonction est appelée sans parameétres
(get_key()), elle retourne immédiatement la chaine
de caractéres vide (").

Lorsque la fonction est appelée avec un parametre
(get_key(1)), elle attend qu’une touche soit
enfoncée.

get_mouse()

Retourne les coordonnées de la souris sous la forme
d’un tuple a deux éléments,

soit la position du pixel de la zone de tracé, soit (-1,-
1) si la position est a I'extérieur de la zone de tracé.

while get_key() !="esc":

Exécutez les commandes dans la boucle « while »
jusqu’a ce que la touche d’échappement « esc » soit
enfoncée.

clear_history()

Efface I'historique de la console (Shell).

get_time_ms()

Retourne le temps en millisecondes avec une
précision de I'ordre de la milliseconde.
Cette fonctionnalité peut étre utilisée pour calculer

une durée plutot que de déterminer I'heure effective
de I'horloge.

Menu Tl Draw

Ce sous-menu est situé sous Plus de modules (More Modules).

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Graphiques Géométrie (Geometry
Graphics). Ceci garantit que tous les modules nécessaires sont importés.

Elément

descriptions

from ti_draw import *

Importe toutes les méthodes du module ti_draw.

Figure
Elément descriptions
draw_line() Trace un segment de droite partant du point de coordonnées
spécifiées x1,y1 jusqu’a point de coordonnées x2,y2.
draw_rect() Trace un rectangle a partir du point de coordonnées x,y spécifiées de
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largeur et de hauteur spécifiées.

fill_rect()

Trace un rectangle a partir du point de coordonnées x,y spécifiées de
largeur et de hauteur spécifiées et avec la couleur de remplissage
spécifiée (via le parametre set_color ou noir si la couleur n’est pas
définie).

draw_circle()

Trace un cercle de centre le point de coordonnées x,y spécifiées et
de rayon spécifié.

fill_circle()

Trace un cercle de centre le point de coordonnées x,y spécifiées et
de rayon spécifié et avec la couleur de remplissage spécifiée (via le
parametre set_color ou noir si la couleur n’est pas définie).

draw_text()

Trace une chaine de texte a partir du point de coordonnées x,y
spécifiées.

draw_arc()

Trace un arc a partir du point de coordonnées x,y spécifiées de
largeur, hauteur et d’angle spécifiés.

fill_arc()

Trace un arc a partir du point de coordonnées x,y spécifiées de
largeur, hauteur et d’angle spécifiés et avec la couleur de
remplissage spécifiée (via le parameétre set_color ou noir si la couleur
n’est pas définie).

draw_poly()

Trace un polygone en utilisant les listes d'abscisses x et d'ordonnées
y spécifiées.

fill_poly()

Trace un polygone en utilisant les listes d'abscisses x et d'ordonnées
y spécifiées et avec la couleur de remplissage spécifiée (via le
parameétre set_color ou noir si la couleur n’est pas définie)..

plot_xy()

Trace une forme en utilisant les coordonnées x,y spécifiées et un
nombre spécifié compris entre 1 et 13 qui représente différentes
formes et symboles (voir ci-dessous).

plot_xy symbols

cor i xs  0000@0
123456789 10111213

Controle (Control)

Elément

descriptions

clear()

Efface la totalité de I’écran. Peut étre utilisé avec les parameétres
(x,y,largeur,hauteur) pour effacer une zone rectangulaire
donnée.
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clear_rect() Efface le rectangle situé aux coordonnées x,y spécifiées de
largeur et hauteur spécifiées.

set_color() Définit la couleur de la ou des formes qui suivent dans le
programme jusqu’a ce qu’une autre couleur soit définie.

set_pen() Définit I'épaisseur et le style spécifiés de la bordure pour le tracé
des formes (non applicable en cas d’utilisation de commandes
de remplissage).

set_window() Définit la taille de la fenétre dans laquelle toutes les formes
seront tracées.

Cette fonction est utile pour redimensionner la fenétre afin

qu’elle corresponde aux données ou pour modifier I'origine (0,0)
de la zone de dessin.

get_screen_dim() Retourne les dimensions xmax et ymax de I'écran.
use_buffer() Active une mémoire tampon hors écran pour accélérer le tracé.
paint_buffer() Affiche le tracé en mémoire tampon.

Les fonctions use_buffer() et paint_buffer() sont utiles lorsque
I'affichage de plusieurs objets a I’écran risque de provoquer des
problémes de ralentissements.

Editeur mathématique

e La configuration par défaut attribue les coordonnées (0,0) au coin supérieur gauche
de I’écran. L’axe des x positifs pointe vers la droite et I'axe des y positifs pointe vers
le bas. Cela peut étre modifié via la fonction set_window().

e Les fonctions du module ti_draw sont uniquement disponibles sur la calculatrice ou
sur la vue calculatrice de I'ordinateur de bureau.

Menu Tl Image
Ce sous-menu est situé sous Plus de modules (More Modules).

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Traitement d’image (Image Processing).
Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

from ti_image import * Importe toutes les méthodes du module ti_
image.

new_image(width,height,(r,g,b)) Crée une nouvelle image avec la largeur (width)

et la hauteur (height) spécifiées pour I'utiliser
dans le programme Python.
La couleur de la nouvelle image est définie par les
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valeurs (r,g,b).

load_image("name") Charge I'image spécifiée par son nom (name)
pour une utilisation dans le programme Python.
L'image doit faire partie du classeur TNS, soit
dans une application Editeur mathématique ou
Graphiques.

L'invite « nom » (name) affiche les noms des
images (si elles ont été nommeées auparavant) ou
un numéro indiquant leur ordre d’insertion.

copy_image(image) Crée une copie de I'image spécifiée par la variable
« image ».

Méthodes de I'objet image

Des fonctions supplémentaires concernant les objets images sont disponibles dans
I’éditeur et la console en tapant le nom de la variable suivi d’un . (point).

@ *zpy 55|
from ti_image import *

:25 get_pixel(x,y)
set_pixel(x,y,color_tuple)
show_image(x,y)

e get_pixel(x,y): Donne la valeur (r,g,b) du pixel a I'emplacement défini par la paire de

coordonnées (x,y).

px_val = get pixel(100,100)
print (px_val)

o set_pixel(x,y,color_tuple): Définit la couleur du pixel spécifiée par un tuple (color_
tuple) a 'emplacement (x,y).
set_pixel (100,100, (0,0,255))

Régle le pixel de coordonnées (100,100) a la couleur (0,0,255).

e show_image(x,y): Affiche 'image avec le coin supérieur gauche a I'emplacement
(xy).

e w, h, name: Permet d’obtenir les parametres largeur (w), hauteur (h) et nom
(name) de I'image.

Par exemple
from ti image import *

# An image has been previously inserted into the TNS document in a Notes
application and named "bridge"

iml=load image ("bridge")

px_val = iml.get pixel (100,100)

print (px val) B

# Set the pixel at 100,100 to blue (0,0,255)
iml.set_pixel (100,100, (0,0,255)
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new px = iml.get pixel(100,100)

print (new px)

# Print the width, height and name of the image

print (iml.w, iml.h, iml.name)

Menu Variables

Remarque : Ces listes ne comprennent pas les variables définies dans d’autres

applications TI-Nspire™.

Elément

descriptions

Vars : Programme en cours

(éditeur uniquement) Affiche une liste de
fonctions et de variables globales définies dans
le programme en cours

Vars: Dernier programme exécuté

(console uniqguement) Affiche une liste de
fonctions et de variables globales définies dans
le programme en cours

Vars: Tout

(console uniguement) Affiche une liste de
fonctions et de variables globales du dernier
programme exécuté et de tous les modules
importés
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Annexe

Mots-clés Python
Mappage des touches dans Python

Exemples de programmes Python

Mots-clés Python

Les mots-clés suivants sont intégrés a I'implémentation de Python dans TI-Nspire™.

False elif lambda
None else nonlocal
True except not

and finally or

as for pass
assert from raise
break global return
class if try
continue import while
def in with
del is yield

Mappage des touches dans Python

Lors de la saisie du code dans I’éditeur ou dans la console, le clavier est congu pour
coller les opérations Python appropriées ou ouvrir des menus afin de faciliter la saisie
de fonctions, de mots-clés, de méthodes, d’opérateurs, etc.

Touche Mappage
Ouvre le menu Variables
stox] Colle le signe =
2] Supprime le caractére a gauche du curseur
clear Aucune action
=] Colle le signe =
ez Colle le ou les symboles sélectionnés :
¢« >
¢« <
) |=
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Touche

Mappage

o >=
o <=

L] ==

o et

¢ —ou—
e non
.«

e &

° ~

Colle la fonction sélectionnée :
* sin

* cos

e tan

e atan2

e asin

® acos

e atan

Affiche des conseils

Colle :=

Colle **

Aucune action

Colle **2

Colle sqrt()

Colle le signe de multiplication (*)

Colle un guillemet anglais (")

Colle le signe de division (/)

Aucune action

Colle exp()

Colle log()

Colle 10**

Colle log(value,base)

Colle (

Colle)
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Touche Mappage
o Colle []
) Colle {}
©) Colle le signe moins (-)
= Ajoute une nouvelle ligne apreés la ligne courante
) Colle E
2 Colle le ou les symboles sélectionnés :
o« ?
o |
e S
. ©
° ll
e %
° n
L]
*
o -
e\
o #
() Colle « pi »
[F] Etat courant de I'indicateur (flag)
Ajoute une nouvelle ligne apres la ligne courante

Exemples de programmes Python

Utilisez les exemples de programmes suivants pour vous familiariser avec les méthodes
Python. Ils sont également disponibles dans le fichier Getting Started Python.tns situé
dans le dossier Exemples (Examples).

Remarque : Si vous copiez et collez un exemple de code contenant des indicateurs
d’indentation par tabulation (- <) dans le logiciel TI-Nspire™, vous devrez remplacer ces
instances par de véritables indentations par tabulation.

Bonjour

# This program asks for your name and uses
# it in an output message.
# Run the program here by typing "Ctrl R"

name=input ("What's your name? ")
print ("Hello, ", name)
print ("\n Press ctrl+R to run again")
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() Python Shell

7

>>>#Running Sample.py
>>>from Sample import *
What's your name? Thornas
Hello, Thomas

>>>

Press ctrl+R to run again
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Exemple de boucle

# This program uses a "for" loop to calculate
# the squares and cubes of the first 5 numbers
#0,1,2,3,4

# Note: Python starts counting at 0

for index in range (5):
square = index**2

cube = index**3
print ("Index: ", index, "Square: ", square,
"Cube: ", cube)

3 Square: © Cube: 27
4 Square: 16 Cube: 64
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Pile ou face

# Use random numbers to simulate a coin flip
# We will count the number of heads and tails
# Run the program here by typing "Ctrl R"

# Import all the functions of the "random" module
from random import *

# n is the number of times the die is rolled
def coin flip(n):
heads = tails = 0
for i in range(n):
# Generate a random integer - 0 or 1
# "0" means head, "1" means tails
side=randint (0, 1)
if (side == 0):
heads = heads + 1
else:
tails = tails + 1
# Print the total number of heads and tails
print (n, "coin flips: Heads: ", heads, "Tails: "

’

tails)

print ("\nPress the Var key and select 'coin flip()'")

print ("In the ( ), enter a number of flips!™)

>>>from Sample import *
o>

Press the Var key and select ‘cain_flipt)’
Inthe (), enter a number of flips!
>>>coin_flip(10)

10 coin flips: Heads: 4 Tails: 6

ESSN
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Graphe

# Plotting example
import ti_plotlib as plt

# Set up the graph window
plt.window(-10,10,-10,10)

plt.axes ("on")

plt.grid (1,1, "dashed")

# Add leading spaces to position the title
plt.title(" TITLE")

# Set the pen style and the graph color
plt.pen("medium", "solid")
plt.color(28,242,221)
plt.line(-5,5,5,-5,"arrow")

plt.pen("thin", "dashed")
plt.color(224,54,243)
plt.line(-5,-5,5,5,"")

# Scatter plot from 2 lists
plt.color(0,0,0)
x1list=[1,2,3,4,5]
ylist=[5,4,3,2,1]
plt.scatter(xlist,ylist, "x")

10 TTLE

fox
x
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Tracé
from ti draw import *

# (0,0) is in top left corner of screen

# Let's draw some circles and squares

# Circle with center at (50,50) and radius 40
draw circle(50,50,40)

# Set color to red (255,0,0) and fill a rectangle of
# of width 180, height 80 with top left corner at

# (100,100)

set color(255,0,0)

f£ill rect(100,100,180,80)

# Set color to green and pen style to "thin"
# and "dotted".

# Then, draw a circle with center at (200,100)
# and radius 40

set_color(0,255,0)

set pen("thin","dotted")
draw_circle(200,100,40)

set color(0,0,0)
draw text (20,200, "Press Enter to exit")

@

Press Enter to exit
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Image

# Image Processing
H

b
from ti image import *
from ti draw import *

# Load and show the 'manhole cover' image
# It's in a Notes app

# Draw a circle on top
iml=load image ("manhole cover")
iml.show_image (0, 0)

set _color(0,255,0)

set pen("thick","dashed")

draw circle(140,110,100)
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Hub

Ce programme utilise Python pour contréler un TI-Innovator™ Hub, un microcontréleur
programmable. Si vous exécutez le programme sans connecter un Tl-Innovator™ Hub,
un message d’erreur apparaitra.

Pour plus d’informations sur le TI-Innovator™ Hub, rendez-vous sur education.ti.com.

#========== TImport Section ==========
from ti hub import *

from math import *

from random import *

from time import sleep

from ti plotlib import text at,cls

from ti system import get key

#======== End of Import Section =======

print ("Connect the TI-Innovator Hub and hit 'enter'"
input ()

print ("Blinking the RGB LED for 4 seconds"

# Set the RGB LED on the Hub to purple
color.rgb(255,0,255)

# Blink the LED 2 times a second for 4 seconds
color.blink(2,4)

sleep (5)
print ("The brightness sensor reading is: ", brightness.measurement())

# Generate 10 random colors for the RGB LED
# Play a tone on the Hub based on the random
# color
print ("Generate 10 random colors on the Hub & play a tone")
for i in range (10):

r=randint (0, 255)

b=randint (0,255)

g=randint (0, 255)

color.rgb(r,g,b)

sound.tone ( (r+g+b) /3,1)

sleep (1)

color.off ()
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Informations générales

Aide en ligne

education.ti.com/eguide

Sélectionnez votre pays pour obtenir d'autres informations relatives aux produits.

Contacter 'assistance technique TI

education.ti.com/ti-cares

Sélectionnez votre pays pour obtenir une assistance technique ou d'autres types de
support.

Informations Garantie et Assistance

education.ti.com/warranty

Sélectionnez votre pays pour en savoir plus sur la durée et les termes de la garantie et
sur I'assistance pour le produit.

Garantie limitée. Cette garantie n'affecte pas vos droits statutaires.
Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243
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